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Getting Started

This chapter describes how to prepare WCS for operation. It contains these sections:

• Prerequisites, page 2-1

• System Requirements, page 2-2

• Installing WCS for Windows, page 2-4

• Installing WCS for Linux, page 2-11

• Starting WCS, page 2-13

• Logging into the WCS User Interface, page 2-14

• Customizing Content on the WCS Home Page, page 2-20

• Using the Cisco WCS User Interface, page 2-22

Prerequisites
Before installing the Cisco WCS, ensure that you have completed the following:

• Met the necessary hardware and software requirements as listed in the “System Requirements” 
section on page 2-2 for Cisco WCS.

• Updated your system with the necessary critical updates and service packs. 

Note Refer to the latest release notes for information on the service packs and patches required 
for correct operation of Cisco WCS.

• Verified that the following ports are open during installation and startup:

– HTTP: configurable during install (80 by default)

– HTTPS: configurable during install (443 by default)

– 1315

– 1299

– 6789

– 8009

– 8456

– 8005
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– 69

– 21

– 162

– 8457

Note Make sure your firewall rules are not restrictive. You can check the current rules on Linux with the 
built-in iptables -L command or on Windows with the Control Panel > Windows Firewall option.

System Requirements
Cisco WCS can be run on a workstation/server class system and access points can be distributed 
unevenly across controllers. The following requirements must be met for the different components.

High-end Server

• Up to 3000 Cisco Aironet lightweight access points, 1250 standalone access points, and 750 Cisco 
wireless LAN controllers.

• 3.16-GHz Intel Xeon Quad processor with 8-GB RAM.

• 80-GB minimum free disk space on your hard drive.

Note The free disk space listed is a minimum requirement but may be different for your system, 
depending on the number of backups.

Standard Server

• Up to 2000 Cisco Aironet lightweight access points , 150 Cisco wireless LAN controllers, and 1000 
autonomous access points.

• 3.2-GHz Intel Dual Core processor with 4-GB RAM.

• 40-GB minimum of free disk space on your hard drive.

Low-end Server

• Up to 500 Cisco Aironet lightweight access points, 200 standalone access points, and 125 Cisco 
wireless LAN controllers.

• 3.06-GHz Intel processor with 2-GB RAM.

• 30-GB minimum free disk space on your hard drive.

Supported Operating Systems

The following operating systems are supported:

• Windows 2003/SP2 and Windows 2003 R2/SP2 32-bit installations with all critical and security 
Windows updates installed. 

Windows 2003/SP2 64-bit installations are not supported.
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Windows 2003 32-bit installations provide support for up to 64 GB of RAM provided Physical 
Address Extension (PAE) is enabled. Refer to Windows documentation for instructions on enabling 
this mode.

• Red Hat Linux Enterprise Server 5.0 or 5.1 32-bit operating system installations. 

Red Hat Linux Enterprise Server 5.0 or 5.1 64-bit operating system installations are not supported.

• Windows 2003 and Redhat Linux version support on VmWare ESX 3.0.1 version and above.

VmWare must be installed on a system with these minimum requirements:
Quad CPU running at 3.16 GHz, 8 GBs RAM, and a 200 GB hard drive.

Individual operating systems running WCS in VmWare must follow the specifications for the size 
of WCS you intend to use.

Client Requirements

The Cisco WCS user interface requires Internet Explorer 6.0/SP1 or Internet Explorer 7.0 with the Flash 
plugin. The Cisco WCS user interface has been tested and verified on a Windows workstation.

Browsing on Windows 2003 Cisco WCS servers is not recommended because recommended Windows 
2003 security settings cause browsing problems. 

The client running the browser must have a minimum of 1 GB RAM and a 2-GHz processor. The client 
device should not be running any CPU or memory-intensive applications.

Note The screen resolution should be set to 1024 x 768 pixels for both WCS and Navigator.

Wireless LAN Controller Requirements

Cisco WCS 5.1.64.0 supports management of the following wireless LAN controllers:

• 4.2.61.0

• 4.2.99.0

• 4.2.112.0

• 4.2.130.0

• 5.0.148.0

• 5.1.151.0

WCS on WLSE

• Up to 1500 Cisco Aironet lightweight access points and 100/375 Cisco wireless LAN controllers.

• 3-GHz Intel Pentium4 processor with 3 GB RAM.

• 38-GB of free space on your hard drive.

WCS Navigator

• 20 WCSs 
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• 30K access points

Installing WCS for Windows
This section describes how to install Cisco WCS for Windows operating systems. Before installing Cisco 
WCS, refer to the “Prerequisites” section on page 2-1 and the “System Requirements” section on 
page 2-2. These sections give an overview of the system requirements and measures that you should take 
prior to the installation. You must have administrator privileges on Windows. If you receive a message 
that a previous version of WCS was detected, you must continue with one of two upgrade options. Refer 
to the “Upgrading WCS” section on page 12-15. 

If installing WCS for Linux, see the “Installing WCS for Linux” section on page 2-11.

Guidelines Before Installing WCS 

• You cannot install the WCS software if the username used to log into the server contains special 
characters such as exclamation marks (!). To ensure successful installation, log into the server using 
a username with no special characters before installing the software.

• Cisco WCS does not support the underscore character (_) in the name of the Windows server running 
the WCS software. If the server name contains an underscore, you can install the WCS software, but 
WCS fails to start. 

• You must install WCS on a dedicated Windows server with no other services running (including 
those running as primary or secondary domain controllers) to avoid conflict with WCS.

• No hard-coded limits exist regarding the number of users or the type of user activities, but a heavy 
memory and CPU load on the server may impact functionality.

To install Cisco WCS, follow these steps:

Step 1 Insert the Windows Cisco WCS CD into the CD-ROM drive and double click the 
WCS-STANDARD-K9-5.1.XX.Y.exe file where 5.1.XX.Y is the software build. If you received the 
installer from Cisco.com, double click the WCS-STANDARD-K9-5.1.XX.Y.exe file that you 
downloaded to your local drive.

Step 2 The Install Anywhere window appears and prepares the system for installation. After a few seconds, the 
Introduction window appears, followed by the license agreement window (see Figure 2-1). You must 
click the “I accept the terms of the License Agreement” option to continue.
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Figure 2-1 License Agreement Window

Step 3 If the install wizard detects a previous version of WCS, you see a window similar to Figure 2-2 or 
Figure 2-3. If a previous version is detected, you must proceed as an upgrade and refer to the “Upgrading 
WCS” section on page 12-15. For a first-time install, continue to Step 4.
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Figure 2-2 Ineligible for Automated Upgrade
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Figure 2-3 Previous Installation Detected

Step 4 The Check Ports window appears (see Figure 2-4). In the Check Ports window, change the default HTTP 
and HTTPS ports if necessary and click Next to open the Choose Install Type window. The default ports 
for HTTP and HTTPS are 80 and 443, respectively.
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Figure 2-4 Check Ports Window

Step 5 Enter and re-enter the root password. The rules for a strong password are as follows:

• The minimum password length is 8.

• The password cannot contain the username or the reverse of the username.

• The password cannot be Cisco or ocsic (Cisco reversed).

• The root password cannot be public.

• No character can be repeated more than three times consecutively in the password.

• The password must contain three of the four following character classes: uppercase, lowercase, 
numbers, and special characters.

Step 6 Enter the root FTP password.

Step 7 From the FTP Server File window, choose a folder in which to store the FTP server files and click Next 
to bring up the TFTP File Server window. 

Note Store the FTP server files in a folder outside the main installation folder. This ensures that the 
FTP server files are not deleted if Cisco WCS is uninstalled.

Step 8 From the TFTP Server File window, choose a folder in which to store the TFTP server files and click 
Next. 
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Note If you want to use a network-mounted drive for the TFTP root, you must configure WCS to run 
as a domain user (see the “Configuring WCS to Run as a Domain User” section on page 2-10) 
and then configure the TFTP root (see the “Configuring TFTP as a Network Drive” section on 
page 2-11).

Note Store the TFTP server files in a folder outside the main installation folder. This ensures that the 
TFTP server files are not deleted if Cisco WCS is uninstalled.

Step 9 If you are installing Cisco WCS on a multi-homed server (a server having multiple interfaces), the 
installer automatically detects the presence of multiple interfaces. The Select Local Interfaces window 
appears (see Figure 2-5). Choose the interfaces to be used by the server for communicating with 
controllers, location appliances and remote FTP servers, and clients. Click Next.

Figure 2-5 Select Local Interfaces Window

Step 10 Choose a folder in which to install the Cisco WCS at the Choose Install Folder window (see Figure 2-6). 
Click Next to continue.
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Figure 2-6 Choose Install Folder

Step 11 Follow the prompts that appear on the screen to complete the installation. After the installation is 
complete, the Install Complete window appears. Click Done to complete the installation.

Note You can check the install log to determine if anything went wrong during the installation. The 
install log is located in the installation root directory if the installation completes. If the 
installation did not complete, the install log resides in the directory from which the installer was 
run or the install root directory.

Configuring WCS to Run as a Domain User
Follow these steps to configure WCS to run as a domain user. 

Step 1 Stop WCS.

Step 2 Add the domain user that will be used to run the service to the Administrators group of the local machine. 

a. Navigate to Administrative Tools > Computer Management > Users and Groups > Groups.

b. Double click the Administrators group.
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c. Add the domain user.

Step 3 Install WCS as instructed in the “Installing WCS for Windows” section on page 2-4.

WCS consists of two services: Cisco Wireless Control System (A.B.C.D) and Nms_Apache_A_B_C_D, 
where A.B.C.D represents the current release number. The same steps are repeated for each service.

Step 4 Set the WCS service to run as the domain user.

a. Navigate to Administrative Tools > Services.

b. Right click on Cisco Wireless Control System (A.B.C.D) and choose Properties.

c. Choose the Log On tab.

d. Click This Account.

e. Enter the domain user with “domain” before the name (such as DOMAIN\username), and the 
domain user password.

f. Click OK. 

Step 5 Set the Apache service to run as the domain user.

a. Navigate to Administrative Tools > Services.

b. Right click on Nms_Apache_A_B_C_D and choose Properties.

c. Choose the Log On tab.

d. Click This Account.

e. Enter the domain user with “domain” before the name (such as DOMAIN\username), and the 
domain user password.

f. Click OK. 

Step 6 Start WCS.

Configuring TFTP as a Network Drive
To configure TFTP as a network, you must have completed the steps in the “Configuring WCS to Run 
as a Domain User” section on page 2-10. The desired drive must also be accessible from that domain.

Step 1 Make a backup of installDir/webnms/classes/com/cisco/packaging/PackagingResources.properties.

Step 2 Edit the following line:

TftpRoot=\\\\servername\\resourcename

where your particular servername and resourcename are entered.

Step 3 Restart WCS.

Installing WCS for Linux
You must have root privileges on Linux. This section describes how to install Cisco WCS for Linux 
operating systems.
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Step 1 If not already done, log in as root. If you are using a graphical environment, open a terminal window. 

Step 2 Using the command line, perform one of the following:

a. If you are installing from a CD, switch to the /media/cdrom directory. Skip to Step 4.

b. If you are installing from Cisco.com, switch to the directory that the install file was downloaded to. 
For example, if the install file was placed in /root/Desktop, enter cd /root/Desktop. Continue to Step 
3.

Step 3 If you downloaded the file from Cisco.com, you need to make it executable using the following 
command:
chmod +x WCS-STANDARD-K9-5.1.XX.Y.bin where 5.1.xx.y represents the current release number.

Step 4 Enter ./WCS-STANDARD-K9-5.1.XX.Y.bin to start the install script.

The install script prepares the install environment and displays the license agreement. You are asked to 
accept the terms of the license agreement.

Step 5 If the install wizard detects a previous version of WCS, you see a message states whether the detected 
version is eligible for an automated upgrade or not. If a previous version is detected, you must proceed 
as an upgrade and refer to the “Upgrading WCS” section on page 12-15. For a first-time installation, 
continue to Step 6.

Step 6 The Check Ports prompt appears. In the Check Ports window, change the default HTTP and HTTPS ports 
if necessary. The default ports for HTTP and HTTPS are 80 and 443, respectively.

Step 7 Enter and re-enter the root password. The rules for a strong password are as follows:

• The minimum password length is 8.

• The password cannot contain the username or the reverse of the username.

• The password cannot be Cisco or ocsic (Cisco reversed).

• The root password cannot be public.

• No character can be repeated more than three times consecutively in the password.

• The password must contain three of the four character classes: uppercase, lowercase, numbers, and 
special characters.

Step 8 Enter the root FTP password.

Step 9 Choose a folder in which to store the FTP server files. 

Note If the folder does not already exist, you must enter mkdir and create it.

Step 10 Choose a folder in which to store the TFTP server files. 

Note Store the TFTP server files in a folder outside the main installation folder. This ensures that the 
TFTP server files are not deleted if Cisco WCS is uninstalled.

Step 11 If you are installing Cisco WCS on a multi-homed server (a server having multiple interfaces), the 
installer automatically detects the presence of multiple interfaces. Choose the interfaces to be used by 
the server for communicating with controllers, location appliances and remote FTP servers, and clients. 

Step 12 Choose a folder in which to install the Cisco WCS.

Step 13 Follow the prompts that appear to complete the installation. After the installation is complete, the Install 
Complete statement appears.
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Note You can check the install log to determine if anything went wrong during the installation. The 
install log is located in the installation root directory if the installation completes. If the 
installation did not complete, the install log resides in the directory from which the installer was 
run or the install root directory.

Starting WCS
This section provides instructions for starting WCS on either a Windows or Linux server.

In Windows and Linux, Cisco WCS is installed as a service. The service runs continuously and resumes 
after a reboot.

Note You can check the status of WCS at any time. To do so, follow the instructions in the “Checking the 
Status of WCS” section on page 12-1.

Starting WCS on Windows
Follow these steps to start WCS when it is installed on Windows.

Note When WCS is installed as a Windows service, WCS runs automatically upon system bootup.

Step 1 Log into the system as administrator.

Step 2 Perform one of the following:

• From the Windows Start menu, click Programs > Wireless Control System> StartWCS.

• From the command prompt, navigate to the WCS installation directory (C:\Program 
Files\WCS32\bin) and enter WCS Admin start.

The WCS Admin window appears and displays messages indicating that WCS is starting.

Note If you are starting WCS after a restore from release 4.0.66.0 or earlier, the startup may take 
longer than expected. The WCS Admin window may even indicate that starting WCS has failed. 
Refer to the task viewer to see whether Java is progressively taking CPU space. If so, WCS is 
running. 

Note If WCS is installed as a service, messages also appear to indicate that the Nms_Server service 
is starting.

Step 3 Close the WCSAdmin window when the Close button becomes active.
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Step 4 WCS is ready to host WCS user interfaces (clients). Go to the “Logging into the WCS User Interface” 
section on page 2-14 to use a web browser to connect to the WCS user interface.

Starting WCS on Linux
Follow these steps to start WCS when it is installed on Linux.

Note To see the version of WCS you currently have installed, enter nmsadmin.sh version.

Note When WCS is installed as a Linux service, WCS runs automatically upon system bootup.

Step 1 Log into the system as root. 

Step 2 Using the Linux command line interface (CLI), perform one of the following:

• Navigate to the /opt/WCS32 directory (or the directory chosen during installation) and 
enter ./StartWCS.

• Navigate to the opt/WCS32/bin directory and enter WCSAdmin start.

The CLI displays messages indicate that WCS is starting.

Step 3 WCS is ready to host WCS user interfaces (clients). Go to the “Logging into the WCS User Interface” 
section on page 2-14 to use a web browser to connect to the WCS user interface.

Logging into the WCS User Interface
Follow these steps to log into the WCS user interface through a web browser.

Step 1 Launch Internet Explorer 6.0 or later on a different computer than the one on which you installed and 
started WCS.

Note Some WCS features may not function properly if you use a web browser other than Internet 
Explorer 6.0 on a Windows workstation.

Step 2 In the browser’s address line, enter https://wcs-ip-address, where wcs-ip-address is the IP address of the 
computer on which you installed and started WCS.

Step 3 When the WCS user interface displays the Login window, enter the root password which was created 
during installation. 

Click Submit to log into WCS. The WCS user interface is now active and available for use. The WCS 
Home page appears. You can predefine what appears on the home page by choosing the monitoring 
components that are critical for your network. For example, you may want different monitoring 
components for a mesh network so that you can create a customized tab for a mesh dashboard.
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Note If the database or Apache web server does not start, check the launchout.txt file in Linux or the 
wrapper.log file in Windows. You will see a generic “failed to start database” or “failed to start the 
Apache web server” message.

This page allows you to choose the information that you want to see. You can organize the information 
in user-defined tabs. The default view comes with default tabs and pre-selected components for each, 
and you can arrange them as you like. 

Note When an upgrade occurs, the user-defined tabs arranged by the previous user in the previous 
version is maintained. Therefore, the latest components may not show. Look at the Edit 
Componenets link to find what new components are added.

This page provides a summary of the Cisco Unified Wireless Network Solution, including coverage 
areas, the most recently detected rogue access points, access point operational data, reported coverage 
holes, and client distribution over time. Figure 2-7 shows a typical WCS Home page. 

You should see 4 tabs on the WCS home page: General, Client, Security, and Mesh. 

Note When you use WCS for the first time, the network summary pages show that the Controllers, 
Coverage Areas, Most Recent Rogue APs, Top 5 APs, and Most Recent Coverage Holes 
databases are empty. It also shows that no client devices are connected to the system. After you 
configure the WCS database with one or more controllers, the WCS Home page provides 
updated information.
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Figure 2-7 WCS Home

Note To exit the WCS user interface, close the browser window or click Logout in the upper right corner of 
the page. Exiting a WCS user interface session does not shut down WCS on the server.

Note When a system administrator stops the WCS server during your WCS session, your session ends, and 
the web browser displays this message: “The page cannot be displayed.” Your session does not 
reassociate to WCS when the server restarts. You must restart the WCS session.
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General Tab

The following are factory default components for the General Tab:

Client Tab

This client tab assists in identifying, diagnosing, and resolving client issues. The following are factory 
default components for the Client tab:

Top APs By Client Count

Displays the five access points with the highest client count showing the following data:

• AP Name—This is the name assigned to the access point. Click an item in the list to see the details 
of that access point. 

• Map Location —The name of the map where the client is located.

• a/n Clients—The number of 802.11a clients currently associated with the controller.

• b/g/n Clients—The number of 802.11b clients and 802.11g clients currently associated with the 
controller.

• Total Client—Total number of clients currently associated with the controller.

Table 2-1 General Tab Components

Component Description

Inventory Detail Status Displays the following:

• Controllers—Lists the number of controllers that are 
managed in WCS. Graphically depicts reachable and 
unreachable controllers.

• Radios—Lists the number of radios managed in WCS. 
Graphically depicts the number of radios in 
out-of-service (critical), minor, and ok conditions.

• Location Servers—Lists the number of location 
servers that are managed in WCS. Graphically depicts 
reachable and unreachable location servers. Check the 
WCS logs to see if anything went wrong while 
manually adding the location servers to WCS. (The 
trace for location servers must be turned on.)

Coverage Areas Displays a graphical representation of client count over 
time with the default option of one day. The time options 
vary from one day to one year. Custom dates can also be 
specified.

Client Count Displays the total number of clients in WCS over the 
selected period of time. 

Recent Coverage Holes Displays the most five recent coverage alarms.

Total APs not yet assigned to Maps Indicates the number of unassigned access points. Click the 
number link to view the list of these access points.
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Most Recent Client Alarms

Displays the five most recent client alarms by default showing the following data:

• Client—IP address, MAC address, or user-defined name of client.

• Date/Time—Date and time of client notification.

• Event Type—Reason for client notification. For example, disassociated, WEP decrypt error, or 
authentication failure.

Click the number in parentheses to access the Alarms page.

Manually Disabled Clients

Provides a link to view a list of manually disabled clients. Click Manually Disabled Clients to access 
this page.

This page enables you to view manually disabled client template information.

• MAC Address—Client MAC address.

• Description—Optional user-defined description.

Client Traffic

A graphic shows the associated clients during a given time frame. The client traffic (bps Out and bps In) 
appears in time increments of six hours, one day, one week, two weeks, four weeks, three months, six 
months, one year, or a custom time frame. 

Security Tab

If you click the Security tab from the WCS Home page, you see the following factory default 
components:

Table 2-2 Security Tab Components

Component Description

AP Threats/Attacks Displays thread or attacks to access points for the 
past hour, past 24 hours, and total active.

Attacks Detected Displays signature attacks for the past hour, past 
24 hours, and total active.

Recent Rogue AP Alarms Displays the five most recent rogue alarms. Click 
the number in parentheses to access the Alarms 
page. Click an item under MAC Address to view 
alarm details.

Recent Rogue Adhoc Alarm Displays the five most recent rogue adhoc alarms. 
Click the number in parentheses to access the 
Alarms page. Click an item under MAC address to 
view adhoc details.

Most Recent Security Alarms Displays the five most recent security alarms. 
Click the number in parentheses to access the 
Alarms page.
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Mesh Tab

If you click the Mesh tab from the WCS Home page, you see the following factory default components:

Customizing Tabs on the WCS Home Page
You can customize the home page from the default four tabs and personalize its look. When you click 
the Edit Tabs link on the WCS Home page, you move to a screen in which customization can begin (see 
Figure 2-8). Follow these steps to create a new tab.

MFP Attacks Displays MFP attacks for the past hour, past 24 
hours, and total active.

Malicious Rogue APs Displays malicious rogue access points for the 
past hour, past 24 hours, and total active.

Cisco Wired IPS Events Displays Wired IPS events for the past hour, past 
24 hours, and total active.

Unclassified Rogue APs Displays unclassified rogue access points for the 
past hour, past 24 hours, and total active.

Friendly Rogue APs Displays friendly rogue access points for the past 
hour, past 24 hours, and total active.

Adhoc Rogues Displays adhoc rogues for the past hour, past 24 
hours, and total active.

Security Index Displays security index for WCS. Also lists which 
security issues are happening the most.

Table 2-2 Security Tab Components

Component Description

Table 2-3 Mesh Tab Components

Component Description

Most Recent Mesh Alarms Displays the five most recent mesh alarms. Click the 
number in parentheses to access the Alarms page.

Worst SNR Link Displays the worst signal-to-noise ratio (SNR) links. Data 
includes the Parent AP Name, the Child AP Name, and the 
Link SNR.

Worst Node Hop Count Displays the worst node hop counts. Data includes the AP 
Name, the Hop Count, and the Parent AP Name.

Worst Packet Error Rate Displays the worst packet error rates. Data includes the 
Parent AP Name, the Child AP Name, and the Packet Error 
Rate.
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Figure 2-8 WCS Home > Edit Tab

Step 1 Enter the name of the new tab you are creating and click Add. The tab name you add appears in the Tab 
Order window.

Note Add is the only function that does not require a Save after its operation. If you click Delete, 
Rename, Move Up, or Move Down, you must click Save for the changes to be applied.

Step 2 Click on the tab names in the Tab Order window and assign placement by clicking Move Up or Move 
Down.

Note If you want to return to the restored factory defaults as shown in Figure 2-7, click Reset.

Customizing Content on the WCS Home Page
You can customize the home page components and personalize its look. When you click the Edit 
Contents link on the WCS Home page, you move to a screen in which customization can begin (see 
Figure 2-8). You can add or delete components by selecting from the predefined list. 

Also part of the customizable home page are time-based or non-time-based interactive graphs which you 
can display in graphical or chart form (by clicking the appropriate icon). (Interactive graphs also appear 
in Monitor > Clients, Location > Location Servers, and Configure > Spectrum Experts.) These graphs 
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refresh automatically within a predetermined time based on the default polling cycles of dependent tasks. 
When a graph is time based, an additional link bar at the top of the graph window displays the options 
as follows:

• 6h—the last six hours of data from the current time and current database table

• 1d—the last day of data from the current time and current database table

• 1w—the last week of data from the current time and the hourly aggregated table

• 2w—the last two weeks of data from the current time and hourly aggregated table

• 4w—the last four weeks of data from the current time and hourly aggregated table

• 3m—the last three months of data from the current time and daily aggregated table

• 6m—the last six months of data from the current time and the weekly aggregated table

• 1y—the last year of data from the current time and weekly aggregated table

• custom—the user can set both the days and hours for the start and end date. The appropriate 
aggregated source (either current, hourly, or daily) is chosen based on the starting date.

After you specify the timeframe, the data for that timeframe is retrieved and the corresponding graph is 
displayed. The link for which the graph is drawn is shown in a different color (orange) than the other 
links. The interactive graphs that are available within WCS include line graphs, area graphs, pie graphs, 
and stacked bar graphs.

You can click Enlarge Chart to enlarge the graph in a separate window. 

Note Hold your mouse over the applicable button for a tool tip identifying the View in Chart or View 
in GridClick the View in Chart button to view the data in a graph. Click the View in Grid button 
to view the data in a table.

There are several components listed in the Available Contents on the WCS Home > Edit Contents 
window. These options and their explanations are as follows:

• Client Security Component—This component displays client security details within the last 24 
hours. The contents include excluded client events, WEP decrypt errors, WPA MIC errors, shunned 
clients, and IPSEC failures in the last hour, last 24 hours, and total.

• Controller CPU Utilization— This component displays in graphical form the average maximum and 
minimum CPU utilizations.

• Most Recent AP Alarms—This component displays the five most recent access point alarms by 
default. You can change the number of alarms to display. The All Alarm link goes to the alarm page 
in which all alarms are visible.

• Recent Alarms—This component displays the five most recent alarms by default. You can change 
the number of alarms to display. The All Alarm link goes to the alarm page in which all alarms are 
visible.

• Rogue AP Detail Summary—This component displays the five most recent rogue alarms. You can 
change the number of alarms to display. The summary provides the MAC address, SSID, type, state, 
and date and time stamp.

• Controller Memory Utilization—This component displays in graphical form the average maximum 
and minimum memory utilizations.

• Clients Detected by Location Server—This component shows the client count detected by the 
location server within the last 15 minutes. You can change the number of minutes to 30 or 60.
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• Client Count—This component displays a graphical representation of the client count over time with 
the default option as one day. The time options vary from one day to one year, or you can enter 
custom dates.

• Inventory Status—The inventory status shows the following:

– Controllers: Lists the number of controllers that are managed in WCS and graphically depicts 
the number of reachable and unreachable controllers.

– Radios: Lists the number of radios managed in WCS and graphically depicts the number of 
radios in out-of-service (critical), minor, or ok conditions.

– Location Servers: Lists the number of location servers that are managed in WCS and graphically 
depicts the number of reachable and unreachable location servers.

• Recent Coverage Holes—This component displays the most five recent coverage alarms. You can 
change the number of alarms to display. 

• Client Traffic—This component displays in graphical form the average traffic in and out for all 
clients located in WCS. 

• Coverage Areas—This component shows the different coverage areas on the map, lists the number 
of access points, radios, and clients within them, and provides a status. You can change the number 
of maps to display.

• Cisco Wired IPS Events—This component displays wired IPS events that have occurred.

• Unclassified Rogue APs—This component displays unclassified rogue access points that have 
accessed the network.

• Friendly Rogue APs—This component displays friendly rogue access points that have accessed the 
network.

• Adhoc Rogues—This component displays adhoc rogue that have accessed the network.

Follow these steps to create new content for the WCS home page.

Step 1 The home page is divided into two parts. From the Available Contents window, highlight the desired 
component and choose to add it to the left column or right column. The component moves to the 
appropriate column.

Step 2 Click the component from the Left Column or Right Column window and designate to move it up, down, 
to the right, or to remove.

Using the Cisco WCS User Interface
A typical Cisco WCS user interface page consists of the areas illustrated in Figure 2-9.
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Figure 2-9 WCS User Interface 

The following sections describe the Cisco WCS user interface page areas and how to use them:

• Menu Bar, page 2-23

• Sidebar Area, page 2-24

• Alarm Dashboard, page 2-25

• Command Buttons, page 2-25

• Main Data Page, page 2-25

• Administrative Tools, page 2-26

Menu Bar
There are five menus on each window: Monitor, Reports, Configure, Location, Administration, and 
Help. When you move the mouse over any of the menus, a drop-down menu appears.

Note The Location menu is displayed only in Cisco WCS Location version.

Monitor Menu

The Monitor menu provides you with a top level description of the devices on your network. You can 
monitor your network, maps, various devices, security, alarms, events, or reports. 

Configure Menu

The Configure menu allows you to configure templates, controllers, and access points on your network. 
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Administration Menu

The Administration menu allows you to schedule tasks like making a backup, checking a device status, 
auditing your network, synchronizing the location server, and so on. You can also choose Logging to 
enable various logging modules and specify restart requirements. You can also choose AAA for user 
administration such as changing passwords, establishing groups, setting application security settings, 
and so on. 

Location Menu

The Location menu allows you to configure location appliances. A location appliance is a Cisco server 
that collects and stores up to 30 days of historical location data for up to 2,500 laptop clients, palmtop 
clients, VoIP telephone clients, active RFID (Radio Frequency Identifier) asset tags, rogue access points, 
and rogue access point clients.

Note The Location menu is displayed only in Cisco WCS location version.

For more information on location appliances, refer to the Cisco 2700 Series Location Appliance 
Installation and Configuration Guide.

Note Read/Write permissions are used by the location function of the location appliance. Write permissions 
allow a client application or location appliance operator to modify location data only (such as asset 
information), while Read permissions only allow a client to read location data.

Note Full permissions are required for administration. All functions under the Locate menu in Cisco WCS are 
administrative functions. An administrator must always have full permissions.

Help Menu

The Help menu allows you to access online help and check the version of Cisco WCS.

To check the version of WCS, click About the Software. The product name, version number, copyright 
statement, and Apache Software Foundation statement is displayed.

Sidebar Area
The sidebar area allows you to choose a new configuration panel under the currently selected menu area. 
You may choose to display or configure any of the available data. The selector area options vary based 
on which menu you have chosen. 

Some windows contain a group of menus in this area. Click the menu item to reveal a submenu and then 
click the item to chose it.
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Alarm Dashboard
When Cisco WCS receives alarm messages from a controller, the Cisco WCS user interface displays an 
alarm indicator in the lower left corner in an alarm summary panel known as the alarm dashboard. The 
alarm dashboard only appears when the Macromedia flash is installed. 

Alarms indicate the current fault or state of an element that needs attention. These are usually generated 
by one or more events. The alarm can be cleared, but the event remains. An example of an alarm is AP 
down, which means that the current status of the access point is down.

Alarms are color coded as follows:

• Clear = No alarm

• Red = Critical alarm

• Orange = Major alarm

• Yellow = Minor alarm

You can click any of the various types of alarms (such as rogues, coverage, security, controllers, access 
points, location, mesh links, and WCS) to display details. 

Command Buttons
The Cisco WCS user interface uses a number of command buttons throughout its windows. The most 
common of these are as follows:

• Apply to Controllers: Applies the selected information to the controllers

• Delete: Deletes the selected information

• Cancel: Cancels new information entered on the current window and returns to the previous window

• Save: Saves the current settings

• Audit: Discovers the present status of this access point

• Place AP: Audits the configuration of the selected entity by flagging the differences between WCS 
database device configurations 

Main Data Page
The main data page is determined by the required parameter information. Active areas on the data pages 
include the following:

• Text fields into which data may be entered using the keyboard

• Pull-downs from which one of several options may be chosen

• Check boxes in lists allow you to choose one or more items from the displayed list

• Radio buttons allow you to turn a parameter on or off

• Hyperlinks take you to other pages in the Cisco WCS user interface

Input fields are black text on a white background. When data is entered or selected, it is not sent to the 
controller, but it is saved in the field until the GO button is selected. 
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Administrative Tools
This area provides shortcuts to administration functions (such as logged in as, logout, refresh, and help) 
that are used on a regular basis when configuring a controller through the web user interface. 
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